
Chapter 3: Creating and Managing Components
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If you have the permissions to do so, you can edit components in place while looking at 
them on your dashboard, or by using the Visual Designer. This chapter shows you how to 
create and edit each of these components.

Editing in Place vs. The Visual 
Designer

There are two mechanics for creating and editing your components: editing in place and 
the Visual Designer. Both offer you access to the same editors and action menus, and 
function nearly identically. The chief difference between the two is that you cannot create 
perspectives, edit empty perspectives, nor create or edit calendars while editing in place. 
While editing in place, however, you can edit dashboards and widgets from the same 
screen and see your changes in context as you make them. 

To create a perspective and add its first dashboard, you must use the Visual Designer. 
After that, you can edit the perspective and add or remove dashboards by editing in place.

Accessing Edit in Place

To begin editing in place, click Edit  in the upper right of the screen. The various editor 
and action menus available appear on the left side of the screen, and the Components 
Library appears, collapsed, on the right. To expand the Components Library, click Expand 

.
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Accessing the Visual Designer

To access the Visual Designer, from the Options drop-down menu, select Visual 
Designer, as shown in Figure 13.

This guide focuses on editing in place, but the editors all work similarly in the Visual 
Designer screen.

Editing Overview

There are several basic areas when you are editing in place. 

Context Pane

The Context Pane is the same as it was before you started editing. It sits at the top of the 
screen and tells you the perspective, level, and period you are looking at. In Figure 14, the 

Figure 13: Selecting Visual Designer.
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Context Pane indicates that the Company Summary perspective is loaded, and is show-
ing the top level for January 2012. A sample of this appears in Figure 14.

The Context Pane also lets you change the time period shown in the components you are 
editing and filter the data shown. See See “Understanding Dashboards and Perspectives” 
on page 8. for more.

Component Library

The Component Library is a collapsible menu on the right side of the screen, and it con-
tains all the widgets, ribbons, and dashboards to which you have access. It also gives you 
the option to create new components. (The Components menu on the Visual Designer 
serves the same function, but displays perspectives as well.)

Both menus show components sorted by types (perspective, dashboard, ribbon, and wid-
get), and the menu displays only one type of component at a time. To switch between 
components, click the buttons at the top of the menu. If you are unsure which button is 
which, mouse over the buttons to display tooltips telling you which component each rep-
resents.The Visual Designer component buttons are shown in Figure 15.

You can scroll down to find the component you want or you can use the search bar. Click 
a component in the Components menu to open it in the editing area, or click the compo-
nent in place if you’re using edit-in-place (a grey shadow appears around the component 
you have selected). 

Figure 14: The Context Pane, expanded.

Figure 15: Component buttons in the Visual Designer.
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On the right side of the Component Library and Components menu tool bars, there is a 

button for Calendars . This lets you access the Time Structure editor.

Editors Menu

After you have selected a component for editing, the Editors menu (shown in Figure 16) 
updates with editing options. The editors that appear depend on what applies to the 
selected component and if you have the permissions to edit the component. (For many 
components, you can only edit their display name.) If no editors appear, you do not have 
the necessary permissions to edit the selected component.

Display Name

This editor lets you change the name of the component. The display name appears at the 
top of the component (for example, a dashboard’s display name is on its tab, a ribbon’s 
display name is in its title bar, and so on) and is used to refer to it in the Components 
menu.

Special characters are not supported in display names.

Aspect Ratio

This editor only appears in the Visual Designer. 

Set how wide you want the widget to be in relation to its height. The options are 1 x 1, 
which makes it a square; 2 x 1; 3 x 1; 4 x 1; 5 x 1; and 6 x 1.

On a freeform dashboard, you can change the height and width manually by clicking and 
dragging the edges of widgets.

Figure 16: The Editors menu.
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Data Settings

Choose the data to show on the widget and what appearance you want each data series 
to have using the Data Settings editor (shown in Figure 17).

Depending on the widget, you can add up to ten series of data. A series can be an 
account, level, metric, or other set of data. 

For users with access to more than one disparate level (that is, levels in different places of 
the Organization Structure), a synthetic level is shown that refers to all those users' levels 
in one place. 

Use the arrows in the Select series section of the editor to change the order of series (this 
affects the order in which they overlap in some widgets, like area and line charts). Click 
Add or Delete to add or delete series.

You can add up to ten series of data in the data editor. Some widgets have a limited num-
ber of series they can display. Those widgets always display that number of series, start-
ing from the top. You can still add up to ten series while editing those widgets, then 
rearrange the series’ order so that the ones you want are displayed.

Click a series to edit it. For each series, you can choose:

• Which version to display (actuals, a specific plan version, or From version selector, 
meaning whatever version the user selects while viewing the widget).

Figure 17: The Data Settings tab in the Data Settings editor. 
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If the actuals version is selected, the Zone Version field appears where you select 
the plan version to be used for calculating zones (see “Account Zones” on page 49).

• Which Account you want the data to come from.

• The Name and Abbreviation to be used for the account on the widget itself (these 
autopopulate with the name and short name of the account, but you can change 
them if you like). 

Note: Administrators can create short names for accounts, versions, levels, 
dimensions, and dimension values. These short names are then used in Mum-
bleware as labels in widgets rather than the whole name. Any changes made to 
the Abbreviation field apply only in Mumbleware, and do not change the short 
name of the account.

• A Data Filter (optional). 

• Whether the Series Y Axis is Primary (appears on the left side) or Secondary 
(appears on the right side). This is particularly useful if the widget displays series 
that use different units (for example, a monetary series and a percentage series)

• What Display Units you want the series to use. 

Although there are default units associated with accounts, you can select different units to 
display data in. The selections are filtered based on the type of metric. When you click the 
down arrow in Display Units, the Current Metric Settings screen (shown in Figure 18) 
appears. 

If the Display Unit has a value set for family, type, and unit format, the values appear in the 
fields on this screen. 

Checking Follow Metric Default sets the family, type, and unit settings to read-only and 
set the values to the default unit for the metric. Unchecking Follow Metric Default lets you 
select different unit display formats. When you click Apply, the units appear in the updated 
format. 

The Appearance Tab allows you to set the appearance of each series of data. You can 
use the default settings or adjust them to customize your widget.

On the Appearance Tab, you can set:

• Series Type: The format the series appears in (for example, a line or an area).

Figure 18: The Current Metric Setting screen.
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• Series Color: The color of the data. Choose from company preset colors or from a 
standard palette.

• Series Shadow: Select whether the series should have a shadow or not.

• Marker Size: Choose the size of the markers for each series of data.

• Marker Style: Assign different shaped markers to different series of data.

• Line Width: Line widgets only. Set the width in pixels of the line representing the 
data.

• Line Style: Line widgets only. Set whether the line representing the data is solid, 
dashed, dotted, or a combination.

• Column Width: Column widgets only. Set the width of the column as a percentage 
of the data point interval.

• Column Style: Column widgets only. Set the appearance of the column from options 
including flat, cylinder, and fade.

Once you have the series set up, you have a set of choices that affect the widget as a 
whole:

• Break down data by: This selection determines how the data of each series is bro-
ken down. Your options are:

• Time: Puts time along the X axis and value on the Y axis.

• Category dimension: Uses whatever you choose in the Category dimension 
drop-down along the X axis.

• Account: Puts accounts on the X axis and monetary value on the Y axis. Useful 
for comparing different departments’ performance, for example.

• Time and Value Dimension: Puts time on the X axis and whatever you select in 
the Value dimension drop-down on the Y axis. Also used when creating stacked 
column charts (see “Stacked Column Chart” on page 110).

• Category and Value Dimension: Puts whatever you choose in the Category 
dimension drop-down on the X axis and whatever you choose in the Value 
dimension drop-down on the Y axis.

• Category dimension: If you choose to break down data by category, this is where 
you specify which category dimension to use.

• Value dimension: Offers you a choice of all accounts, levels, and dimensions in 
your model.

The Pinned check boxes let you “pin” your selection so that the widget won’t change even 
if a user changes the context for the dashboard it’s on. For example, if you set the Cate-
gory dimension to a particular level, a user viewing the widget can change that level by 
changing the level in the Context Pane. Checking the Pinned check box next to the Cate-
gory dimension drop-down causes that selected level to stay the same regardless of 
changes made in the Context Pane.

The Labels tab (line, area, and column widgets only) lets you specify the settings for the 
selected series’ labels. Its fields are:

• Show Data Labels: Select whether to display data labels on the widget.

• Label Position: Set the data label position relative to the data points. 

• Label Type: Select between Data values, Percentage of total value, and X-axis 
label.
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• Label Precision: Set the decimal point precision of the data labels.

The Y Axis tab appears only if the widget is in dual or multi-chart mode. It lets you specify 
the settings for the Y axis of the selected series.

• Y Axis Scale: Select between Auto and Manual. 

• Y Start From Zero: Auto only. Specify whether the Y axis starts at zero.

• Y Axis Maximum: Manual only. Specify the highest point on the Y axis.

• Y Axis Minimum: Manual only. Specify the lowest point on the Y axis.

• Y Axis Interval: Manual only. Specify the interval of marks on the Y axis.

The Empty Points tab (line, area, and column widgets only) lets you specify the settings 
for how the selected data series displays data points for which there is no value. 

• Show Empty Points: Select Yes to display empty points, No to hide them.

• Empty Point Value: Select Average to assign the average of the points on either 
side of the empty point to the empty point, or select Zero to assign a value of zero to 
empty points.

• Color: Select a color for empty points. 

• Line Style: Select a line style to use when the series contains empty points.

• Marker Style: Select a marker style for empty points.

Grid Widget Column Properties

Although this does not appear as a window in the Editors menu, it serves a similar func-
tion to the Data Settings editor. To access this window, mouse over the heading of a col-
umn and click the drop-down arrow (shown in Figure 19).

The Column Properties editor has three tabs:

• Data (varies depending on the column type)

• Name: The full name of the column.

• Short name: The abbreviated name of the column, used when Short Name is 
selected in Header display or when the column is too narrow for the full name to 
fit. If no short name is specified for the account or metric, the system generates 
one automatically.

• Header display: Choose whether columns default to the full name or the short 
name.

• Reference: The first number in the variance calculation.

Figure 19: The drop-down arrow for accessing the Column Properties editor.
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• Comparison: The second number in the variance calculation.

• Formula: This automatically displays the formula created by the drop-down 
selections above it.

• Version: Select the version the column references.

• Units: Select the units for the column, or leave it set to the default.

• Summary Row: If a summary row has been placed in the grid, select what it dis-
plays for this column.

• Show zone: If zones have been set up for this data series, check this box to 
enable them for the grid. 

• Expression: Click Edit Expression  to enter a formula for this column.

• Display

• Alignment: Select the alignment for the cells in the column.

• Foreground color: Select the color for text and symbols in the column.

• Background color: Select the color for the background of the cells in the column.

• Format: Make the column text bold, italic, or underlined.

• Border Sides: Select the borders that should appear around the column’s cells.

• Border Format: Select the type of border the column should have.

• Border Color: Set the color of the column’s border.

• Conditional Formatting

• The editing window at the top is where the list of format rules are displayed. To 

add a format rule, click Add, then click Edit  for the new entry. The Expression 
dialog appears, where you can enter a format rule. 

• The lower section includes all the editors from the Display tab except for Align-
ment. To set a format rule’s format properties, click it in the list, then edit the vari-
ous display options. 

Note: Format rules are applied in the order in which they appear in the list. To 
change the order of the list, highlight the rule you want to move, then click the up 
and down arrows  to move it up or down in the list.

Chart Settings

Set the properties of the widget, including font size and legend style. The tabs and fields 
displayed vary from widget to widget. The possible fields are as follows:

• Chart tab

• Default Chart Type: Set the chart type to be used when the widget series (Data 
Settings Editor > Appearance Tab > Series Type) is set to Default Chart Type.

• Chart Display Format: Choose between 2D and 3D.

• Chart Area tab

• Chart Areas: Choose whether to display the series on a single chart, a dual chart 
(two charts), or multiple charts (one chart per series). 

• Font

• Font: Select the font to use in the chart.

• Size: Select the font size to use in the chart.
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• Style: Choose among Standard, Bold, Italic, or combinations of the three.

• Color: Choose a color for the text in the chart.

• Show Border: Select whether to show a border around the chart.

• Show Background: Select whether to show a background color on the chart. 

• Back Start Color: If Show Background is set to Yes, select a color for the back-
ground to start as.

• Back End Color: If Show Background is set to Yes, select a color for the back-
ground to gradient fade to from the Start Color.

• Back Gradient: If Show Background is set to Yes, select whether to use a gradi-
ent on the background and if so, what direction the gradient runs.

• Y Axis tab

• Y Axis Scale: Select between Auto and Manual.

• Y Start From Zero: Auto only. Specify whether the Y axis starts at zero.

• Y Axis Maximum: Manual only. Specify the highest point on the Y axis.

• Y Axis Minimum: Manual only. Specify the lowest point on the Y axis.

• Y Axis Interval: Manual only. Specify the interval of marks on the Y axis.

• Y Axis Title: Specify the title to appear along the Y axis. If you select Custom 
Name, enter the title you want in the next field. 

• Y Custom Title: If Y Axis Title is set to Custom Name, enter the custom name 
here.

• Y Interlaced Grid: Choose whether to have the background of the chart display a 
grid along the Y axis. If a color gradient is set on the Chart Area tab, the gradient 
will increment according to the grid.

• Y Major Gridlines: If set to Yes, lines will appear for the intervals on the Y axis.

• Y Minor Gridlines: If set to Yes, lines will appear subdividing the intervals on the 
Y axis.

• Y2 Axis tab: Controls the Y axis on the right hand side of the chart. This tab only 
appears you selected Secondary on the widget series (Data Settings Editor > Data 
Settings Tab > Series Y Axis)

• Y2 Axis ScaleSelect between Auto and Manual.

• Y2 Start From Zero: Auto only. Specify whether the Y axis starts at zero.

• Y2 Axis Maximum: Manual only. Specify the highest point on the Y axis.

• Y2 Axis Minimum: Manual only. Specify the lowest point on the Y axis.

• Y2 Axis Interval: Manual only. Specify the interval of marks on the Y axis.

• Y2 Axis Title: Specify the title to appear along the Y axis. If you select Custom 
Name, enter the title you want in the next field. 

• Y2 Custom Title: If Y Axis Title is set to Custom Name, enter the custom name 
here.

• Y2 Interlaced Grid: Choose whether to have the background of the chart display 
a grid along the Y axis. If a color gradient is set on the Chart Area tab, the gradi-
ent will increment according to the grid.

• Y2 Major Gridlines: If set to Yes, lines will appear for the intervals on the Y axis.
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• Y2 Minor Gridlines: If set to Yes, lines will appear subdividing the intervals on the 
Y axis.

• X Axis tab: Controls the X axis on the widget.

• Offset Lables: Alternates positions of the X axis labels. Useful if the labels are 
long.

• Label Angle: Non-offset labels only. Select the angle of the X axis labels in 
degrees.

• Label Interval: Set to Auto or select the interval for the X axis labels. 

• Auto Fit Labels: Select whether the system should shrink the labels to fit or not.

• Label Format: Select whether the X axis labels should be consecutive numbers 
or not.

• Label Text: Select whether to use the series short name or long name in the X 
axis labels.

• Major Gridlines: If set to Yes, lines will appear for the intervals on the X axis.

• Minor Gridlines: If set to Yes, lines will appear subdividing the intervals on the X 
axis.

• Legend tab: Controls the appearance of the widget’s legend.

• Type: Select a Standard, Short Summary Table, or Long Summary Table for the 
legend.

• Legend Text: Select what the legend will display for each series.

• Position: Select the legend’s shape and location.

• Font: 

• Font: Select the font to use in the legend.

• Size: Select the font size to use in the legend.

• Style: Select among Standard, Bold, Italic, or combinations of the three.

• Color: Select a color for the text in the legend.

• Border: Specify whether the legend has a border or not.

• Custom tab

• Column Position: Column charts only. Select whether the columns appear side 
by side or superimposed on each other.
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Scorecard Settings

The Scorecard Settings editor (shown in Figure 20) appears when you are editing a 
scorecard widget. It defaults to the most commonly-used settings, so you don’t need to 
change anything here unless you want to. 

Layout Tab

The Layout tab gives you control over how the elements in the scorecard are formatted 
and arranged.

• Scorecard Layout: Select the arrangement of the elements within the scorecard. 
Examples of each at the full 6x1 width are given in “Scorecard Layouts” on 
page 133. 
Default: Base and Previous Periods.

• Maximum Series: Set the maximum number of series of data (rows) which can be 
included on the scorecard. Set a specific number, or let the application display as 
many as fit (auto).
Default: Auto.

• Show Cell Borders: Choose whether to show the cell borders in the scorecard. 
Default: No.

• Show Interlaced Rows: Whether to show alternate rows in grey and white. 
Default: No.

• Indicator Icon Size: Sets the display size of the zone and trend icons. Choose Auto 
to let Mumbleware pick which size fits, based on the number of rows in the score-
card.
Default: Auto.

Figure 20: The Layout tab of the Scorecard Settings editor.
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• Micro Chart Borders: Whether to show borders around the micro chart(s) in the 
scorecard. 
Default: No.

Header Style Tab

Change the look and style of the Scorecard’s header.

• Header Back Color: Set the background color of the header row. Select Default to 
use the company color.
Default: (Default)

• Header Font Size: Set the size of the text in the header row.
Default: 8

• Header Font Style: Set the font style of the header row. 
Default: Bold

• Header Font Color: Set the color of the text in the header row. Select Default to 
use the company color.
Default: (Default)

• Metric Header Text: Set the label for the Metric field. 
Default: Account

• Metric Header Tooltip: Set the tooltip text for the Metric field. 
Default: Account

• Budget Header Text: Set the header text for the Plan field.
Default: Plan

• Micro Chart Header: Set the header text for the micro chart.
Default: Micro Chart

Content Style Tab

Change the look and feel of the text content of the scorecard.

• Data Font Size: Set the font size for data in the scorecard. 
Default: 8

• Data Font Style: Set the font style for data in the scorecard. 
Default: Standard

• Data Font Color: Set the color for the data text in the scorecard.
Select Default to use the company color.

• Name Text: Choose whether the rows label should be the full display name, abbre-
viated display name, or default (this setting uses the full display name when there is 
room for it, and the abbreviated display name otherwise).
Default: Default

• Name Font Size: Choose the font size of the row labels. 
Default: 8.

• Name Font Style: Choose the font style of the row labels. 
Default: Standard

• Name Font Color: Choose the font color for the row labels.
Select Default to use the company color.
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Supplementary Data Tab

Change the look and behavior of the indicators, micro chart, and other data visualization in 
the scorecard.

• No Zone Indicator: When there is no zone defined for a data point on the score-
card, display either no zone indicator or a Good indicator.
Default: None

• Trend Indicator Period: Choose the period for the trend indicator.
Default: Consolidated Period

• If Base Period is selected, the widget’s base period is used to determine trends 
(the widget’s base period can be fixed with the Time Settings editor, or set to use 
the time period chosen in the Period Selector).

• If Consolidated Period is selected, the widget’s consolidated time period is used 
to determine trends (if the widget’s time period is Month, the consolidate period is 
Quarter or Year. Thus, the widget would look at the current quarter or current year 
to determine the trend. Consolidated periods are set in the Time Structure). 

• If Historical Period is selected, the previous consecutive periods is used to deter-
mine trends (if the widget’s time period is Month, then the previous n months is 
used, where n is set in the Time Structure). 

• Micro Chart Period: Choose the period for the micro chart. Default: Consolidated.

• If Base Period is selected, the widget’s base period is used to determine trends 
(the widget’s base period can be fixed with the Time Settings editor or set to use 
the time period chosen in the Period Selector).

• If Consolidated Period is selected, the widget’s consolidated time period is used 
for the micro chart (if the widget’s time period is Month, the consolidated period is 
Quarter or Year. Thus, the micro chart displays the current quarter or current 
year). 

• If Historical Period is selected, the previous consecutive periods are used for the 
micro chart (if the widget’s time period is Month, then the previous n months 
appear in the micro chart, where n is set in the Time Structure). 

• Micro Chart Type: Choose the type of chart used for the base micro chart. 
Default: Outline.

• Summary Type: Choose the logic applied for data summary. 
Default: Average.

• Variance Type: Choose between Actual Variance (a numerical amount) or Per-
centage Variance in the Variance column. 
Default: Actual Variance.

• Previous Period: Choose between sequential (for example., the previous month for 
a scorecard looking at a month) and comparable (for example, the same month the 
previous year for a scorecard looking at a month, which is governed by the widget’s 
Time Structure.). 
Default: Previous Sequential Period.

• Consolidated Data Range: Choose to show data for period-to-date or for the total 
period if Consolidated Period is selected in the Micro Chart Period or Trend Indi-
cator Period settings.
Default: Show data for period to date.
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Custom Scorecard Settings

Custom scorecards use a scorecard layout, but you have a great deal of flexibility in what 
information you display and how it appears. For example, the custom scorecard can com-
pare Forecast to Budget versions, current year Actuals to last year Actuals, and so on. 
You can also rearrange the order of the display columns and the display settings of the 
data in the scorecard.

A sample custom scorecard appears in Figure 21. Custom scorecards have three sec-
tions. Each section can have from one to seven columns, which can contain a wide variety 
of information, such as value, variance, variance percentage, zone, trend, or microchart. 

Many of the custom scorecard editors are similar to the editors for other widgets, but there 
are some significant differences. This section describes the editors specific to custom 
scorecards.

Figure 21: Sample custom scorecard.
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Data Settings Editor

You add rows to a custom scorecard using the Data Settings editor (shown in Figure 22).

Enter information on the Data Settings tab about an account. (This tab is discussed in the 
earlier section on the Data Settings editor. See “Data Settings” on page 28.) You can add 
another row by clicking Add. You can also use the Data Settings editor to change the 
order in which rows appear by selecting a row and using the up and down arrows to move 
it to the desired place. 

Note: Large custom scorecards with lots of rows can take noticeably longer to 
refresh or update than other widgets. This is because a custom scorecard can 
have as many as 630 data cells, each of which may require multiple calls and 
queries to retrieve and calculate the information that appears in the cell.

Figure 22: The Data Settings tab of the Data Settings editor.
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The Row tab (shown in Figure 23) has a single setting on it for setting the row height.

The Label tab (shown in Figure 24) lets you set the colors, font size, font style, font color, 
and label alignment of the row labels. 

Figure 23: The Row tab of the Data Settings editor.

Figure 24: The Label tab of the Data Settings editor.
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The Data tab (shown in Figure 24) lets you set the row height, cell color, font size, font 
style, font color, and data alignment for the cells in the custom scorecard.

Section Editors

Custom scorecards have three sections for time. Each of these sections can have from 
one to seven columns. Because each section is usually a different period and can have 
different columns with unique settings, each section has its own section editor. You use 
section editors to set the section name, number of columns, period, period alignment, data 
range, comparison criteria, and other display and comparison settings. Figure 26 shows 
the Section tab in a section editor.

The Section tab lets you set the name for the section and specify the number of columns 
in the section. 

• Section Header Text: Enter the section name. This appears above the section. The 
sections default to time values (Month, QTD, and YTD) but you can use any group-
ing you like. 

• Section Columns: Enter a number from 0 to 7 to specify the number of columns in 
the section. If you enter 0, the section does not appear.

Figure 25: The Data tab of the Data Settings editor.

Figure 26: The Section tab in a section editor.
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The section editor displays a column tab for each column specified in the section. 
Figure 27 shows a typical column tab. 

The Column tabs let you specify the kind of information to display in that column as well 
as how the information in that column is formatted. The options that appear on the tab are 
based on the column type you select: 

• Value: Displays a value. Lets you specify the version, period type, period alignment, 
and data range.

• Variance: Displays a variance amount as calculated against another version and 
period. Lets you specify the version, period type, period alignment, data range, com-
parison version and comparison period alignment.

• Percent Variance: Displays a variance percentage as calculated against another 
version and period. Lets you specify the version, period type, period alignment, data 
range, comparison version and comparison period alignment.

• Zone: Displays a zone. Lets you specify the version, period type, period alignment, 
and data range.

• Trend: Displays a trend variance by drawing a straight line linear regression on the 
specified data and identifying the slope of the line. Lets you specify the version, 
period type, period alignment, data range, and breakdown period type.

• Microchart: Displays a microchart. Lets you specify the version, period type, period 
alignment, data range, breakdown period type, chart color, and chart type.

Appearance Settings Editor

The Appearance Settings editor lets you modify the appearance of the entire widget, 
headers, row labels, and data. 

Figure 27: A column tab in the section editor.
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The Table tab (shown in Figure 28) lets you set the appearance for the custom scorecard.

• Show Cell Borders: Select Yes to display cell borders in the custom scorecard or 
No to suppress cell borders. 
Default: Yes.

• Show Table Border: Select Yes to display a border around the custom scorecard or 
No to suppress the border. 
Default: Yes.

• Border Color: Select the color to use for all borders.
Default: The default color.

The Headers tab (shown in Figure 29) lets you set the appearance of section and column 
headers.

• Row Height: Enter a row height between 10 to 60 for the section and column head-
ers.
Default: 40.

Figure 28: The Table tab of the Appearance Settings editor.

Figure 29: The Header tab of the Appearance Settings editor.
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• Display Text: Select Name or Short Name to display either the name or short name 
for the headers.
Default: Name.

• Row Color: Select the fill color to use for all header cells. 
Default: The default color.

• Font: Select the font size, characteristics, and font to use for all header cells.
Default: 8, Bold, and the default font.

• Alignment: Select the text alignment in the header cells.
Default: Center.

The Labels tab (shown in Figure 30) lets you set the appearance of the row labels.

• Column Width: Enter a column width between 100 to 500 for the row labels.
Default: 200.

• Display Text: Select Name or Short Name to display either the name or short name 
for the row.
Default: Name.

• Column Color: Select the fill color to use for the row labels. 
Default: The default color.

• Font: Select the font size, characteristics, and font to use for the row labels.
Default: 8, Bold, and the default font.

• Alignment: Select the text alignment in the row labels.
Default: Left.

Figure 30: The Header tab of the Appearance Settings editor
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The Data tab (shown in Figure 31) lets you set the appearance of the cells within the cus-
tom scorecard.

• Row Height: Enter a row height between 10 to 60 for the cells. (This setting also 
affects the height of the row labels.
Default: 30.

• Cell Color: Select the fill color to use for the cell color. 
Default: The default color.

• Font: Select the font size, characteristics, and font to use for the cells.
Default: 8, Bold, and the default font.

• Alignment: Select the text alignment in the cells.
Default: Right.

Figure 31: The Data tab of the Appearance Settings editor
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Table Settings

Layout Tab

Set the basic layout for the table.

• Table pages: Set the number of times the table’s columns repeat horizontally. This 
can be useful for tables where the Break down data by setting results in a large 
number of rows.

• Data rows: Set the number of rows of data to display.

• Highlight alternate rows: If No, all rows have a white background. If Yes, alternate 
rows have a gray background.

• Show table borders: Select whether to display the table’s borders or not.

Header Tab

Set the properties of the table’s header row.

• Show table header: Choose whether or not to display the header row.

• Header height: Set the height of the header relative to the rows in the table. For 
example, selecting 1.0 for the header height makes it the same height as the rows, 
while selecting 2.0 for the header height makes it twice as high as the rows.

• Header background color: Set the background color for the header row.

• Header text color: Set the color for the text in the header row.

• Header font size: Set the size of the text in the header row.

Figure 32: The Table Settings editor.
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• Label header font style: Choose whether the label header is bold, italicized, under-
lined, or some combination of the three. The label header is the header row cell 
above the column whose entries label the rows of the table.

• Label header alignment: Choose whether the label header is aligned to the left, 
center, or right. 

Labels Tab

Controls how the labels for the rows appear.

• Label column width: Set the width of the label column. The default is for all col-
umns to be of equal width.

• Label text: Choose whether to show the full display name of the labels, or to use the 
abbreviated display name. Abbreviated names are automatically generated unless 
set by administrators.

• Label text alignment: Choose whether the label text should be aligned to the left, 
right, or center in the label column.

• Label text color: Set the color for the label text.

• Label font style: Choose whether the label text is bold, italicized, underlined, or 
some combination of the three. 

• Label font size: Set the font size for the label text.

• Label cell color: Set the cell color for the label column. 

Data Tab

Controls the appearance of the data cells in the table.

• Data text color: Set the color for the data text.

• Data font size: Set the font size for the data text. 
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Data Filter

Filter the data used for the widget (for example, sort by expenses in ascending order, or 
show only the first 100 records). The Data Filter editor is shown in Figure 33.

Click a filter on the right to use it, then click any bold term to edit it. In Figure 33, “only the 
first n% of records” has been selected, and both “first” and “10” can be edited.

Zone Bands

Enable or disable zone bands for the widget. Zone bands highlight data in different ranges 
with symbols and colors, letting you see at a glance if an account is dangerously low, if 
your department is under budget, and other similar data-range information. A sample wid-
get showing zone bands appears in Figure 34. In this sample, the zones change in rela-

Figure 33: The Data Filter editor
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tion to the budget values. If the zones were set to specific numbers, they would remain 
constant. See Table 2 on page 18 for definitions of the different icons.

Account Zones

The Account Zone editor (shown in Figure 35) lets you set the data ranges for the 
account’s zones and the ranges for zone alerts. Account zones apply to all widgets an 
account appears in, so you only have to set them up once for each account. 

Note: Depending on your company’s theme, the icons for zones and other 
icons and graphics may be slightly different from the images shown.

In Figure 35, the settings are:

• Trending upward is an improvement.

• A change of less than 10% does not cause any alerts to display.

Figure 34: A widget with percentage zone bands in place. 

Figure 35: The Account Zone editor.
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• A 10% - 24% change upward or downward causes a Trending alert to appear on the 
widget. 

• A 25% or greater change upward or downward causes a Trending Quickly alert to 
appear on the widget.

• The numbers in the account zone fields (here, 70, 80, and 110) are percentages 
rather than fixed numbers.

• If Net Income is 70% or less than budgeted, it is in the Bad zone, and an alert 
appears on the widget.

• If Net Income is 70%-80% of budget, it is in the Warning zone, and an alert appears 
on the widget.

• If Net Income is 80%-110%, it is in the Good zone.

• If Net Income is 110% of budget or greater, it is in the Excellent zone, and an alert 
may appear on the widget.

Analysis Settings

Choose the analysis settings for the widget and the behavior of zone alerts. The options 
are:

• Default Analysis View: Choose the analysis view used for the widget. Standard 
causes the widget to show the data as it is in the app, with no analysis applied. 
Select an analysis view to have the data run through analysis before being dis-
played. Which views are available depends on the type of widget.
Default: Standard

• Show Data Zone Alerts: Choose whether to show zone alerts in all views, analysis 
views only, or never.
Default: Yes, show Zone Alerts

• Show Zone Alerts: Choose whether to show alerts in the upper left corner of the 
widget or not.
Default: Yes

Context Settings

Appears only for perspectives. When you customize the order of the perspectives, the 
Override display order check box is automatically checked. If you would like to revert to 
the default display order, uncheck this box.

Display Order Settings

Change the order in which perspectives appear in the Context Pane perspectives drop-
down menu, by user.

Top N Filter

This editor appears only for grid widgets. It lets you filter the grid based on one of the col-
umns and only display the top N rows. Its fields are:

• Top: How many rows should be displayed. 
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• Sort column: Which column should be used for sorting the grid.

• Sort direction: How the column should be sorted, in ascending or descending order.

Advanced Filter

This editor appears only for grid widgets. It lets you create complex filters by composing 
expressions. Once applied, only rows that meet the conditions of the filter are displayed.

The order of the list is the order in which the filters are applied. Filters can be moved up 
and down the list of filters with the arrow buttons in the lower left of the editor. 

To add a new filter, click Add, then the edit icon  in the New row. 

To remove a filter, click it in the list to highlight it, then click Remove.

Actions Menu

The Actions menu (shown in Figure 36) lets you grant other people access to your com-
ponents and perform other actions.  

• Edit Metrics: Open the Data Components editor. 

• Save: Save the currently-selected component.

• Copy to ‘Personal’ folder: This option duplicates the component and places the 
copy in your personal folder. The original version is unedited, and any changes you 
make in the future to the copy in your folder only affect that copy, not the original.

• Copy to common folder: Copying a component to the common folder makes a 
duplicate of it available to anyone with access to the folder.

• Publish this component: Perspectives are the only component that can be pub-
lished. When you publish a perspective to another user or group of users, it 
becomes available to them along with their other perspectives in the main Mumble-
ware screen area. This is a way to give other users access to widgets, ribbons, and 
dashboards you have created when they do not have the ability to use the Visual 
Designer. If you edit the perspective or any of its components in the future and pub-
lish it again, it updates the perspective for the users you publish to. Only users with 
Edit Company Mumbleware Dashboard permission have access to this function. For 
more on how to publish a perspective, see “Dial Design Best Practices” on 
page 116.

Figure 36: The Actions menu
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Publishing a component lets you give specific people access to your component 
when they open the Visual Designer. If they include your component in one of their 
dashboards, any changes you make to the component appear on their dashboards 
as well. Any changes that the other user or users make to the component also show 
on your dashboard, however. If you want to share a component without having to 
worry about the other people changing it, you can do so by making a copy of it and 
sharing the copy, keeping the original for your own use.

• Delete this component: Deleting a component removes it from your personal folder 
or the company folder, if it is a company component. If you have shared it with any-
one else, it is no longer available to them.

Data Components Menu

The Data Components menu appears when you click Edit Metrics in the Actions menu. 
It displays all the various data series available for inclusion in widgets, and appears when 
you select a dashboard or widget to edit. You can click and drag any series from the menu 
onto a blank spot on the dashboard to open the Create New... dialog and create a widget 
using that series. You can also drag data series onto widgets already on the dashboard to 
add them to the widget.

The Data Components menu is especially handy for creating and editing grid widgets. 
For a detailed example of how to do this, see See “Creating a Grid Dial” on page 91.

The types of data components available depends on the widget you are editing. Most wid-
gets use Metrics, which are data series such as accounts or downtime, you can add to 
widgets. 

Metrics can be dragged right onto a freeform dashboard to create a new widget showing 
that data series.

Data Components Editor

The Data Components editor lets you add and edit metrics/accounts in the Data Compo-
nents menu. When you select a metric/account to edit or right-click and select to create a 
new one, the appropriate tabs and fields appears in the main pane. 

You can organize your metrics/accounts into folders by right-clicking the parent folder and 
selecting Add > Metric folder in the right-click menu. Click and drag metrics/accounts into 
the folders where you want to keep them.

The fields of the editor and their uses are:

• Settings tab

• Name: The name of the metric/account.

• Short Name: The name to be used where the metric/account short name is dis-
played. 

• Budget Name: The name of the corresponding budget/target version.

• Units: The units of the metric’s/account’s values.

• Minimum Period Type: Non-selectable time granularity. 

• Expression tab (calculated metrics only)
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• Disabled Variable Handling: Behavior if one of more metrics used in the calcula-
tion are disabled. The options are:

• Disable Metric: Disable the calculated metric as well.

• Ignore Variable: Ignore the metric that was disabled and compute the calcu-
lated metric based on the other metrics. 

• Null Variable Handling: Behavior if one or more metrics used in the calculation 
have a null value. The options are:

• Use null value: Use null in the calculation.

• Use zero: Use a value of 0 instead of null value. 

• Expression: The expression to be used in the calculated metric. Click the arrow 
icon to see a list of the available fields and functions. Begin typing in any field to 
narrow the list of functions until you find the one you want. For assistance in cre-
ating the expression, click the metric formula help link under the Expression field.

• Dimensions tab

• Mapped Dimensions: The list of dimensions available for drill for the metric. The 
default is all dimensions. Use the checkboxes to disable dimension drill-downs for 
metrics.

To create a calculated metric, do the following:

1. Click Edit Metrics in the Actions menu.
The Data Components Editor opens.

2. Select the folder where you want the calculated metric to be stored, then right-click 
on it. Alternately, create a new folder and select it.

3. Select Add > Calculated Metric from the right-click menu.

4. Use the fields to design your calculated metric.

5. Click Apply.

6. Click Close.

Grid Widget Data Components

Grid widgets let you create a table of data, similar to a report. As a result, a much longer 
list of data components appear in the Data Components menu compared to other widget 
types. These components are:

• Calculated Columns: Contains calculations you can add to a grid widget as a col-
umn, like Expression, Variance, etc. 

• Periods: Contains units of time, which can be added to a grid widget as a column.

• Metrics: Data series, such as accounts, paint inventory, and downtime, which you 
can add to widgets.

• Dimensions: Contains all dimensions available to you, such as Level, Department, 
and Title.

• Rows: Contains analysis rows, which can be added to a grid widget.
R, LLC. All rights reserved.  |  Confidential – Do not Duplicate or Distribute  53



Copyright © 2015 SS

SSR Mumbleware User Guide Creating and Managing Components
File Actions Bar

The File Actions bar (shown in Figure 37) gives you the ability to save the work you have 
done on a component you were editing, close the component currently open in the main 
editing area, and return to the dashboards you were viewing before opening the Visual 
Designer.

• Click Save to save the changes you have made to a component.

• Click Close to close the component you have been working on.

• Click Return to Dashboards to return to the Mumbleware screen’s main view. 

Main Editing Area (Visual Designer Only)

When you are using the Visual Designer, the central portion of the screen is where compo-
nents you create and edit appear, and where some of your editing work is done.

To open a component for editing, click its name in the Components menu.

To add a component to the component currently open for editing (for example, adding a 
dashboard to a perspective, or a widget to a freeform dashboard), drag the component 
from the Components menu and drop it where you want it.

To change a component’s position (for example, to move a widget to a different place on a 
dashboard, or to reorder the ribbons in a dashboard), click and drag the component where 
you want it to go. Any other components rearrange around it.

Formatting Hierarchies

You can use multiple editors to set the appearance of some widgets, and in some cases 
(particularly labels and fonts), the appearance settings may differ. There is a strict hierar-
chy of which settings override other settings. 

If you are making changes to label colors or fonts and they are not appearing on your wid-
get, a higher-level setting is probably overriding the setting you are changing.

If a tab mentioned in the hierarchies listed below does not display for the widget you are 
editing, then it does not apply to the widget and is skipped in the hierarchy.

For label color settings:

• The Cell Color setting on the Label tab in the Data Settings editor overrides any 
other settings. If this is set to (Default), then:

• The Label Column Color setting on the Label tab in the Appearance Settings editor 
is applied. If this is also set to (Default), then:

• The Header Row Color setting on the Header tab in the Appearance Settings editor 
is used.

Figure 37: The File Actions bar. 
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For font settings:

• The Font Style setting on the Data tab of the Data Settings editor overrides any 
other settings. If it is set to (Default), then:

• Column widgets only. The Column Font settings (Month Font, Quarter Font, and 
Year Font) on the Column tab of the Appearance Settings editor are used. If it is set 
to Default, then:

• The Data Font setting on the Data tab of the Appearance Settings editor is used.

If a higher level setting is set, changing a lower level setting will not affect the widget. For 
example, if the Font Style setting on the Data tab of the Data Settings editor is set to 
Bold, changing the Data Font setting on the Data tab of the Appearance Settings editor 
will not change the appearance of the widget, because the Font Style setting is higher in 
the hierarchy and overrides the Data Font setting.

Using Components Created by Others

When you first get started using Mumbleware, you’ll find a few starter components ready 
to use and ready to customize to make it easier to dive right in and start using the 
advanced capabilities offered by Mumbleware. As you and your coworkers begin creating 
components, you may find more components available to you in the Company folder or 
shared directly with you by others. 

Using Shared Components

When another user shares a component with you, a folder named Shared appears with 
your other folders (Personal, Company, and Starter). You can then add components to 
your own perspectives, dashboards, and ribbons. 

It’s important to keep in mind that shared components can still be edited by the person 
who created them. If you place a shared widget created by someone else on your dash-
board, for example, and they make changes to it, you see the changes on your dash-
board. 

If you want to keep a shared component exactly as it is, copy it to your personal folder and 
then use it from there.

Using Company Components

Company components are available to you in a special folder, named after your company, 
in the Components menu. These components can only be created and edited by users 
with the Edit Company Mumbleware Dashboard permission.

You can add company components to your perspectives, dashboards, and ribbons as you 
would any other component. 
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If you like a company component but want to edit it for your own use, save a copy of it to 
your personal folder (use the Copy to personal folder option in the Actions menu) and 
edit the copy.

Using Starter Components

A starter perspective containing one dashboard, which holds three rows of widgets, has 
already been created for you. The widgets contained in this dashboard are:

• Expense Line Graph: A line graph showing data from the PL Expense accounts.

• Expenses by Level Column Chart: A column chart showing the expenses for each 
level.

• Expenses by Level Pie Chart: A pie chart showing the portion of total expenses 
made up by each level.

• Net Income Line Graph: A line graph showing data from the Net Income account.

• P&L Scorecard: A scorecard comparing profits and losses based on the PL Income, 
Non-Operating Income, PL COGS, PL Expense, Non-Operating Expenses, and Net 
Income accounts.

For information on customizing the starter components for your own or for company use, 
see “Customizing Starter Dials” on page 84.

Creating Your Own Components

Creating your own components lets you get Mumbleware set up exactly the way you need 
it to be. You can create the exact widgets, ribbons, dashboards, and perspectives that are 
the most useful for you, and share them with others who have similar needs. 

By creating your own widgets in particular, you can make very complex data unique to 
your company visible in one place, so you have a clear picture of what’s going on at your 
company and can make your decisions based on up-to-date data and projections.

This section walks you through creating each type of component. 

Note: Generally speaking, it’s quickest to create a component by dragging Cre-
ate New [Component] onto the perspective, dashboard, or ribbon where you 
want the new component to go. If you want to create a new component without 
adding it to an existing perspective, dashboard, or ribbon, open the Visual 
Designer and click Create New [Component] in the Components menu. You 
can always add the component to a perspective, dashboard, or ribbon in the 
future by opening the location where you want to place it and dragging it from the 
Components menu onto the perspective, dashboard, or ribbon. Be sure to click 
Save Layout when you’re done.

Creating a Perspective

Perspectives are the only component that must be created in the Visual Designer.
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To create a new perspective, do the following:

1. Open the Visual Designer by clicking Options  and selecting Visual Designer.

2. Click Perspectives  on the Components menu.

3.  Expand the Personal Perspectives folder and click Create New Perspective.
The Create New Perspective dialog appears.

4. Click the New Perspective template and specify a name.

5. Click Create.
The new perspective appears in your Personal Perspectives folder.

6. Click your new perspective’s name to load it in the main editing area.

Your new perspective is ready to have one or more dashboards added to it. The first dash-
board must be added in the Visual Designer, but subsequent dashboards can be added 
using editing in place.

Creating a Dashboard

To create a new dashboard using editing in place, do the following:

1. Open the perspective to which you want to add the new dashboard.

2. Click Dashboards  on the Components menu.

3.  Expand the Personal Dashboards folder and drag the Create New Dashboard 
item onto your perspective.
The Create New Dashboard dialog appears.

4. Click either the New Standard Dashboard or New Freeform Dashboard template 
and specify a name. (Standard dashboards use ribbons to organize widgets, while 
freeform dashboards do not, you just place the widgets wherever you like.) 

5. Click Create.

To create a new dashboard in the Visual Designer, do the following:

1. If the perspective you want to put the dashboard on isn’t already open, click Per-
spectives  on the Components menu and click the perspective’s name to open 
it.

2. Click Dashboards  on the Components menu.

3.  Expand the Personal Dashboards folder and drag the Create New Dashboard 
item onto your perspective.
The Create New Dashboard dialog appears.

4. Click either the New Standard Dashboard or New Freeform Dashboard template 
and specify a name. (Standard dashboards use ribbons to organize widgets, while 
freeform dashboards do not, you just place the widgets wherever you like.) 

5. Click Create.

6. Click Save Layout in the lower left corner of the screen.

Your new dashboard is now ready to have one or more widgets (if it’s a freeform dash-
board) or ribbons (if it’s a standard dashboard) added to it.
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To add a dashboard to a perspective, open the perspective, then locate the dashboard in 
the Components Library or Components menu and drag it from the menu to the perspec-
tive. 

Creating a Ribbon

Ribbons are only needed to hold widgets on standard dashboards. If you’re using a 
freeform dashboard, you don’t need to create a ribbon. 

To create a new ribbon, do the following:

1. If the dashboard you want to put the ribbon on isn’t already open, click its tab to 

open it (if you’re using the Visual Designer, click Dashboards  on the Compo-
nents menu and click the dashboard’s name to open it).

2. Click Ribbons  in the Components menu.

3. Expand the Personal Ribbons folder.

4. Drag Create New Ribbon onto the dashboard where you want the ribbon to go.
The Create New Ribbon dialog appears.

5. Click the New Ribbon template and specify a name.

6. Click Create. The new ribbon appears in your Personal Ribbons folder.

7. If you’re in the Visual Designer, click Save Layout in the lower left corner of the 
screen.

All your new ribbon needs is one or more widgets, and your new perspective are ready to 
use.

To add a ribbon to a dashboard, open the dashboard, then locate the ribbon in the Compo-
nents Library or Components menu and drag it from the menu onto the dashboard.

Adding Widgets to Dashboards

To add a widget to a freeform dashboard, open the dashboard, find the widget in the Com-
ponents Library or Components menu, and drag it from the list into place.

To add a widget to a standard dashboard, you must drag it from the list into place on a rib-
bon.

Creating Widgets

Creating widgets is far more involved than creating the other components, because there 
are such a vast array of options to choose from. See “Dial Creation Walkthroughs” on 
page 66 for detailed instructions on creating widgets.
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Resizing Widgets on a Freeform Dashboard

One of the differences between a standard dashboard and a freeform one is that the 
freeform dashboard lets you resize widgets and arrange them however you want. In the 
sample dashboard shown in Figure 38, there are no ribbons holding widgets on this 
freeform dashboard, and the Net Income Line Graph widget and Income Line Graph wid-
get have been shrunk to fit one atop the other next to the Expense Line Graph widget. 
Meanwhile, the P&L Scorecard widget has been expanded to make it easier to read.

To resize a widget, hover your mouse pointer over the edge you want to change (or a cor-
ner if you want to change two edges). When it changes to a double-headed arrow, click 
and drag. The widget’s new outline appear as a dotted grey line, and when you release 

Figure 38: A freeform dashboard.
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your click, the widget resizes to the new boundaries. A sample of this appears in 

Figure 39.

To move a widget, just click on it and drag it to the position where you want it.

Sharing

Once you’ve made several components, you may find that you want to share them with 
your coworkers. You can do that with just a few clicks, making your components available 
for coworkers to add to their perspectives, dashboards, and ribbons.

Be aware that sharing makes the component available for editing, not just for using. If you 
share a widget with someone and they edit it in the Visual Designer, the changes appear 
when you look at the widget because it’s the same widget. If you need to, make a copy of 
your component before sharing it by clicking Copy to personal folder in the Actions 
menu.

To share a component, do the following: 

1. Open the component you wish to share by clicking its name in the Components 
menu.

2. Click Share this Component in the Actions menu.
The Share dialog appears.

3. Double-click one or more usernames in the Available list to add them to the 
Selected list.

4. To see exactly which users you are publishing to, check the show all individuals 
box. 
This makes the dialog view-only. To resume adding names to the list, uncheck the 
box.

5. To remove a name from the Selected list, double-click it.

When you are satisfied with the Selected list, click Save to share your component.

               
Figure 39: Resizing a widget
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Publishing

Publishing lets users with publishing permissions to make a perspective and any dash-
boards, ribbons, and widgets it contains visible to other users (individual subcomponents 
cannot be published). When you publish a perspective to another user or group of users, it 
becomes available to them along with their other perspectives in the main Mumbleware 
screen area.

To publish a perspective, do the following:

1. Click Perspectives in the Components menu.

2. Click the name of the perspective you want to publish to load it in the main editing 
area.

3. Click Publish this component in the Actions menu.The Publish dialog appears.

4. Double-click one or more usernames or level names in the Available list to add 
them to the Selected list.

5. To see exactly which users you are publishing to, check the Show all individuals 
box. This makes the dialog view-only. To resume adding names to the list, uncheck 
the box.

6. To remove a name from the Selected list, double-click it.

7. When you are satisfied with the Selected list, click Save to publish your perspec-
tive.

Unpublishing

After a perspective has been published, you can effectively unpublish it in a similar fash-
ion. This means the perspective and its included components no longer appear in users’ 
lists of perspectives in the main Mumbleware screen area. You can unpublish a perspec-
tive from a single user, or several users, or all users.

To unpublish a perspective, do the following:

1. Click Perspectives in the Components menu.

2. Click the name of the perspective you want to unpublish to load it in the main edit-
ing area.

3. Click Publish this component in the Actions menu.The Publish dialog appears.

4. Double-click one or more usernames or level names in the Selected list to remove 
them.

5. To see exactly which users have access, check the Show all individuals box. 
This makes the dialog view-only. To resume removing names from the list, uncheck 
the box.

6. To add a name to the Selected list, double-click it in the Available list.

When you are satisfied with the Selected list, click Save.

Now, only the users designated in the Selected list have access to the perspective.
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